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국문초록                              

                 

                  컴퓨터 음악 교수법에 관한 연구

                         김    동    영

                제주대학교  교육대학원 음악 교육전공

                        지도교수   장 홍 용 

교사들은 전통적 음악 수업의 문제점을 해결하기 위해 끊임없이 새로운 교수 방법과 매체의 도입을 

연구해 왔다. 1980년대 개인용 컴퓨터의 대중화와 함께 음악 교육에서도 컴퓨터를 수업에 활용하고자 

하는 노력이 시도되었다. 또한 MIDI(Music Instrument Digital Interface)의 도입 이후 컴퓨터와 악

기, 주변기기간의 연결이 수월해져 컴퓨터는 음악 교육의 여러 분야에서 활용할 수 있게 되었고, 컴퓨

터 음악 프로그램을 활용하여 작곡, 편곡, 편집 등의 전문적인 작업뿐만 아니라 화성, 리듬, 음정 교

육, 악보 편집, 및 출력 등을 활용하여서 교육 분야에서도 활용 가능성을 높일 수 있다.

본 논문의 결과를 요약하면 다음과 같다.

1) 학생들의 음악수업에 흥미를 유발시킬 수 있다.

음악을 직접 듣고 악보를 볼 수 있으므로 기존의 전통적인 지필 사용의 음악 수업에 비하여 학생들의 

흥미를 유발시키는 효과가 크다. 또한 건반악기의 연주능력이 부족한 학생들에게도 매우 효과적이다. 

한 번에 한 음씩 입력이 이루어지므로 누구나 음악을 만들 수 있으며 악기연주 능력과는 상관없이 자

신의 음악적 능력을 최대한 발휘할 수 있다.

2) 모든 학생들이 능동적으로 수업에 참여하게 할 수 있다.

학생들은 컴퓨터와 전자음악에 관심이 많으므로 기기를 소개함으로써 자발적인 학습 의욕을 높이게 

되어 학습의 효과와 능률을 높일 수 있다.

4) 악보를 인쇄할 수 있다. 

자기가 만든 곡을 인쇄하여 다른 사람에게 보여줄 수 있으며 연주할 수 있다. 여러 곡을 모아서 개인

이나 학급단위의 작곡집을 만들 수도 있다.

5) 템포 조절이 가능하다. 
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음악의 분위기에 맞는 템포를 들어보면서 수정할 수 있고 곡의 일부분의 템포도 변경할 수 있다.

6) 셈여림의 표현이 가능하다. 

채널별 셈여림은 물론 한 채널 안에서도 특정 음이나 마디의 셈여림을 표현할 수 있다. 특히 셈여림의 

강도는 숫자로 표시되기 때문에 비교되는 다른 부분과의 강약을 세밀하게 표현할 수 있다.

7) 마디를 복사, 삭제, 붙이기 등을 손쉽게 할 수 있다. 

이러한 기능들은 곡을 수정하는데 편리하게 사용되며 같은 가락이 반복될 경우 간단하게 복사하여 붙

임으로써 작업의 효율성을 높일 수 있다.

8) 이조가 가능하다. 

가창 수업의 경우 반주 음악이 너무 높거나 낮아서 부르기 힘들면 조바꿈  메뉴로 간단하게 해결할 

수 있다. 관현악 편곡의 경우 조가 서로 다른 악기를 배열할 때도 활용도가 높다.

9) 편곡하기가 쉽다. 

노트에 연필로 악보를 그리는 편곡은 누군가가 그 곡을 연주해 주어야만 음을 듣고 수정하거나 보완

할 수 있지만 컴퓨터 음악에서는 작업 도중에 일부분 또는 전체를 들어 보며 어울림을 감지하여 수정

할 수 있다.

10) 채널 별 연주가 가능하다. 

전체 채널 연주, 멜로디 채널만 연주, 반주 채널만 연주, 특정 채널만 연주, 원하는 몇 개의 채널만 연

주가 가능하며 학습 목적에 맞게 이용할 수 있다. 예를 들면 독창을 할 때 선율 반주로 익숙해지면 멜

로디 채널을 제외한 나머지 채널만 선택하여 무선율 반주로 노래할 수 있다. 이러한 기능은 테이프나 

CD에서는 불가능하다.

11) 서로를 칭찬하고 격려하여 음악에 대한 긍정적 태도를 가지게 할 수 있다. 

컴퓨터 음악을 활용한 경우 교사나 지도자의 일방적인 칭찬 이외에도 소프트웨어를 이용하여 훌륭한 

음악을 만든 데서 얻을 수 있는 성취감이나 보상 심리가 작용하여 한층 높은 강화 작용을 할 수 있

다.1)

※  이 논문은 년  월 제주대학교 교육대학원 위원회에 제출된 교육학 석사학위 논문임.
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Ⅰ 서론

1. 연구의 필요성과 목적

과학문명의 발달은 인간 생활을 매우 복잡하게 하면서도 한편으로는 더욱 편리한 

생활을 가능하게 하는 것 같다. 20세기에 들어오면서 그 발달은 더욱 가속도로 

발전하여, 학교 교육에 컴퓨터가 처음 도입된 것은 1980년대 이었는데, 불과 20

년도 되지 않아 학교의 많은 교육 활동들이 컴퓨터를 도구로 하여 이루어지고 있

는 게 사실이다. 교수 ∙ 학습과정에서도 컴퓨터는 자료의 제시나 학습의 진행 과

정에서 학습의 효율성과 목표의 성취를 위한 중요한 도구로 인식되어지고 있다.2)

그렇기 때문에 컴퓨터가 더욱 보편화되어질 미래 사회를 살아가야 할 학생들에게 

컴퓨터의 사용법과 사용 목적에 따라 효율적으로 사용할 수 있는 능력을 배양해 

주어야 한다.

컴퓨터 공학의 발달은 빠른 속도로 교육 분야를 침투하고 있다. 교육 전문가들은 

컴퓨터 공학의 대중화를 미래의 교육 분야에서 예상되는 변화 중 가장 중요한 요

소로 지목하고 있다. 몇 년 전만  하더라도 교육자들은 컴퓨터를 교육 기자재로 

보는 시각보다는 단순한 행정 사무 도구로 인식하는 경우가 많았다. 즉 미래의 도

구인 컴퓨터를 비싸고 사용하기가 어려워서 일부 전문가들만이 소유하고 사용할 

수 있다는 생각 하에 수업에 활용될 수 있는 새로운 교수 도구로서 받아들이지 

않았다.

그러나 현재는 교육에 영향을 주고 있는 새로운 변화를 긍정적으로 받아들이고 

있고, 많은 교육 분야에서 컴퓨터를 활용하여 수업하고 있다. 학교 교육에서도 빼

놓을 수 없는 교수 도구로 등장하게 되었으며 공학 자체의 발전으로 말미암아 전

보다 가격이 인하되어 다양한 프로그램 개발로 활용가치가 높아짐에 따라 더욱 

빠르게 우리의 교실에서 컴퓨터를 접할 수 있게 되었다. 미래의 교육을 전망해 볼 

2)박진홍, “컴퓨터 음악을 활용한 웹 기반 감상학습 전략”, 부산교육대학원, 석사학위 논문, 2002, 

p1.
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때 음악 교육에서 컴퓨터 활용의 가능성과 잠재력은 대단하다.3)

따라서 본 연구에서는 컴퓨터 음악을 효율적으로 지도하기 위하여 다음과 같은 

몇 가지 방법을 구안, 적용하고자 한다.

첫째, 컴퓨터 음악 지도에 활용하기 위한 장비에 대해 조사한다.

둘째, 음악의 흥미 도를 분석한다.

셋째, 음악 수업에 활용도가 높은 컴퓨터 음악 프로그램을 설정한다.

넷째, 수업에 활용할 자료를 개발하여 사이버 공간에 두고 예습, 복습을 할 수 있

도록 제작한다. 

이런 점에서 본 연구의 필요성은 개개인의 음악적 잠재력과 창의성을 계발하고, 

음악을 통하여 자신의 감정과 생각을 표현하도록 하며, 삶의 질을 높이고 음악적 

능력 계발에 길잡이가 되고자 하는데 있다.

  

 2. 연구의 방법 및 범위

본 연구는 전통적인 교수학습 방법 보다는 음악 교육이 학습자들에게 흥미를 가

지고 수업에 임할 수 있도록 음악 교육의 효율성을 높이는 방안을 모색하고자 

컴퓨터가 음악교육에 어떻게 활용되어 질 수 있는가를 여러 관련 자료 및 음악

교육 자료를 통한 문헌 연구 방법에 의하여 컴퓨터 음악의 개관과 발달과정을 

살펴보고, 컴퓨터 음악을 할 수 있도록 프로그램의 유형을 분류하여 그 프로그램

들이 음악교육에 어떻게 활용되어지고 교육적 가치가 어떤 것인지 자료를 통해 

연구하고자 한다. 

연구의 방법은 자료 및 선행연구 논문 등의 문헌 연구 방법에 의하여 컴퓨터 음

3)석문주, ⌜음악적 성장을 위한 음악과 교수∙학습 지도⌟, 서울:풍남, 1997, p277.
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악 교육의 활용성을 제시하고자 한다. 음악 교과서를 분석하여 컴퓨터 음악을 활

용한 음악 지도 요소별 지도 방안을 개발하여 제시함으로써 컴퓨터 음악을 보조

적인 수단이 아닌 중심 역할을 하는 교수 도구로서의 근거를 마련하고자 한다.

연구 범위는 실제 수업에 활용되는 사례를 제시하여 고등학교 음악 수업에 초점

을 맞추었고 제시된 사례도 고등학교 음악 교과서를 대상으로 하였다.

 

3. 연구의 제한점

1)본 연구에서는 시판중인 모든 음악 프로그램을 다룰 수 없으므로 많이 사용되

어지는 프로그램을 소개하였다.

2)고등학생들이 쉽게 익히고 다양한 기능을 제공하는 미디 프로그램을 중심으로 

제시하였다.

3)본 연구의 대상은 고등학교 학생이므로 고등학교 교과서를 중심으로 수업 사

례를 만들었다.
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Ⅱ 본론

 

1. 컴퓨터 음악의 이론적 배경

1) 컴퓨터 음악의 개념

컴퓨터 음악이란 컴퓨터를 사용해 디지털 신디사이저나 주변 가공장치들을 제어

하여 만드는 음악을 의미한다. 즉 컴퓨터에서 악보를 그리거나 편집하고, 또 만들

어진 악보를 출력할 수도 있고 컴퓨터가 여러 악기들을 제어함으로써 음악을 작

곡하고 연주하는 것을 의미한다.

컴퓨터에 음악 소프트웨어를 설치하여 작곡에 이용할 수 있는데, 악상을 원하는 

대로 그려주면서 바로 그 음을 들을 수도 있고, 또 많은 수정을 하더라도 그 악보

를 깨끗한 상태로 유지할 수 있다. 뿐만 아니라 필요에 따라 만들어진 악보를 프

린터로 출력해 볼 수도 있다.

컴퓨터를 전자 악기와 연결하여 사용하면 건반악기 하나로 현악기, 국악, 새소리, 

물소리 등 다양한 음을 표현할 수 있으며 혼자서도 여러 사람이 연주하는 것처럼 

오케스트라 음을 만들어 낼 수도 있다.4)

  

2) 컴퓨터 음악의 유형

컴퓨터 음악은 컴퓨터만을 도구로 사용하는 것과 신디사이저나 다른 악기의 힘을 

빌려 음악을 연주하는 두 가지 형태가 있다.

컴퓨터 자체로만 음악을 하는 경우는 컴퓨터 기능만을 이용해 음을 발생시키는 

것으로 “컴퓨터=악기”라는 등식이 성립되는데 컴퓨터 내부에 장착되어 있는 자체 

스피커나 입력된 데이터에 따라 음을 발생시키는 것이다. 베이직(Basic)이나 파스

칼(Pascal) 등이나 프로그래밍 언어를 이용하여 음악 프로그램을 작성하여 컴퓨터

에 실행시켜서 음악을 듣는 경우가 이런 형태이다. 후자의 경우는 미디인터페이스

4) 이미경, ⌜컴퓨터와 음악의 만남⌟, 서울:정보시대 컴퓨터 주니어 통권2호, 1990.5, pp197~198.
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를 통하여 한대 또는 여러 대의 전자악기와 컴퓨터를 연결시키고 컴퓨터가 이 전

자악기들을 통제하는 형태이다.

컴퓨터를 사용한 음악적 활동은 거의 후자의 경우로 행해지고 있다.5)

  

3) 컴퓨터 음악을 위한 시스템

컴퓨터 음악을 위한 시스템은 미디 관련 장비들을 연결하고 다루며 음악적으로 

쓸모 있는 그 무엇을 창출해내는 도구들을 말한다. 컴퓨터 음악을 위한 장비들과 

소프트웨어의 종류에 대하여 알아보면 다음과 같다.

가. 하드웨어

A. 컴퓨터 (Computer) 

<그림1>

컴퓨터는 미디 소프트웨어의 구동 및 작업의 저장, 미디 인터페이스 카드를 통한 

주변기기와의 데이터 입/출력 등 매우 필요한 장비이다. 

초기의 미디 프로그램은 컴퓨터 그래픽 파일에 비하여, 과거 도스용 운영체제와 

286급에서도 작업을 수용할 수 있을 정도로, 빠른 속도나 많은 용량의 메모리를 

5) 송혜영, “교육공학의 음악지도로의 접근적 고찰”, 서울:한양대학교 대학원 석사학위논문, 1990, 

p24.
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필요로 하지 않았다. 

그러나 지금은 운영체제가 윈도우 95/98 이상 급으로 전환되었고, 미디 프로그램

들도 윈도우용으로 많이 향상되었기 때문에 운영체제를 원활히 구동시키기 위해

서라도 당연히 펜티엄급 이상 되어야하겠고 다양한 멀티 작업을 하려면 CPU와 

RAM의 향상이 뒤따라야 한다.

그리고 IBM 호환 PC 이외에 매킨토시 컴퓨터가 있는데, 이 컴퓨터는 Mac OS 

8.5를 기본 운영체제로 사용하며 IBM 호환 PC 보다는 가격이 비싸지만 컴퓨터 

음악 전문 소프트웨어가 있는 것이 장점이다.6)

B. 마스터 키보드 (Master Keyboard)

<그림 2>

마스터 키보드의 일반적인 형태는 피아노나 오르간과 같은 건반 보양을 하고 있

는데, 그 자체가 음원을 가지지 않기 때문에 스스로 소리를 내지 못한다. 따라서 

반드시 미디로 연결된 음원을 필요로 한다. 마스터 키보드의 장점은 음고와 음의 

강도 및 제한된 음색 변화만을 구사하는 기능 이외에 음악적 표현을 위한 글리산

도, 비브라토, 소리 이동, 프로그램의 변화 등의 여러 기능들을 수행할 수 있다는 

것이다.

6) 남기영, ⌜FINALE 98의 모든 것⌟, 서울:혜지원, 1999, p18.
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C. 음원 (Sound Module)

<그림 3>

실제 음원은 각 악기의 소리를 가지고 있는 장치로 건반과 같은 입력 장치는 없

고 단지 소리만 담겨져 있는 기기로 발생되는 음질을 좌우하는 중요한 장치이다. 

초창기의 음원은 발진기 등을 이용한 아날로그의 음원이 주류를 이루고 있었으나 

마이크로프로세스의 개발과 더불어 디지털 방식의 음원개발이 속속 이루어지고 

있으며 소리 발생 알고리즘의 개발 역시 많은 연구가 이루어지고 있다.

D. 신디사이저 (Synthesizer)

<그림 4>

여러 가지 악기의 음원을 가지고 있으며 특별한 장치를 통해서 악기 소리를 만들

어내는 기계장치를 말한다. 최근의 신디사이저는 실제 악기 음색의 파형을 그대로 

만들어 내기 때문에 자연스러운 소리를 낸다. 기존의 악기 음색의 파형을 녹음하

는 방법과는 차이가 있으므로 각 악기 제조사의 방식마다 다른 소리의 특성을 가

진다. 음을 합성하여 소리를 창출하기 때문에 다른 소리로 변형하는 것도 가능하
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고 그렇게 변형한 소리를 하나의 악기처럼 사용할 수 있는 장점이 있다.

E. 미디 인터페이스 카드 (MIDI Interface Card)

<그림 5>

미디 인터페이스란 서로 다른 디지털 신호를 사용하는 컴퓨터와 미디 악기를 연

결하여 데이터를 송수신하기 위한 도구이다.

나. 소프트웨어

ⅰ) 연주용 소프트웨어 (Sequencing Software)

A. Logic Audio

<그림 6>
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작곡가들에게 가장 많은 사랑을 받아오던 프로그램이며 이 소프트웨어는 악보 제

작 및 연주를 위한 기능이 강력한 복합적인 기능을 갖추고 있다. 즉, 시퀀싱 기능

과 DAW 기능, Score 기능이 뛰어난 프로그램이다.

B. Digital Performer

<그림 7>

  

디지털 퍼포머의 특징은 미디 입출력을 비롯한 오디오 입출력의 설정이 매우 쉽

고 간결하여 초보자도 쉽게 프로그램을 사용할 수 있다.

C. Cakewalk for Windows

<그림 8>
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이 소프트웨어는 IBM 호환 PC전용이다. 가장 큰 장점은 넓은 사용자층을 가지고 

있다는 점이며 자체 매크로가 있다는 것이다. 일일이 수작업하기 까다로운 부분들

을 한꺼번에 해결할 수 있다는 것인데 예를 들면 C4음(가온다)의 벨로시티의 수

치를 지정해 주면 한꺼번에 처리해 준다.

D. Cubase SX

<그림 9>

Cubase SX는 Steinberg 사의 메인 프로그램으로서 전 세계적으로 많은 사용자를 

확보하고 있는 오디오 시퀀싱 프로그램이다.

Cubase의 가장 강점이라면 높은 해상도의 작업을 지원한다는 것과 ASIO를 지원

하는 오디오 카드와 맞물려 품질 좋은 오디오 레코딩을 할 수 있다는 것이다.

C. Studio Vision Pro

악보를 위주로 한 입력과 편집기능이 편리해서 악보에 익숙한 사람에게 편리하다. 

하지만 Studio Vision Pro나 Logic Audio처럼 정확한 제어를 하기에는 역부족이

다. 미국과 일본에 사용자가 많으며 국내에서 널리 사용되는 Cakewalk for 

Windows와 유사한 환경을 가지고 있어 적응하기는 편하다. 
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ⅱ) 악보 제작용 소프트웨어 (Notation Software)

A. Finale

<그림 10>

현대 음악에서 사용되어지는 어떠한 기호라도 표현이 가능하며 시중에 선보이는 

많은 악보들이 이 소프트웨어로 제작된다. 하지만 편집 툴은 복잡하고 연주용 소

프트웨어로서의 기능은 미약하다.

B. Encore

<그림 11>
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이 소프트웨어는 쉽고 간단하면서도 비교적 쓸만한 악보를 기록해 준다. 피날레에 

비하면 강력한 편집 툴이 돋보이지만 Overture보다는 기능이 떨어진다. 학생들이 

많이 사용하고 있으며 작곡용으로도 일부 이용된다.

 

C. Music Printer Plus

  IBM용으로 개발된 악보 인쇄와 연주를 겸한 소프트웨어이다. 일반적으로 다른 

시퀀스 프로그램에 비해 연주에 대한 기능은 다소 불편하지만 단순하면서도 깨끗

한 악보 인쇄 기능으로 관심을 모은다.

D. Song Works

  멜로디 라인(Melody Line)만 입력하면 곡의 하모니를 들어볼 수도 있으며, 조

와 화성 진행을 입력하고 권장 멜로디를 요구하면 프로그램 자체에서 멜로디가 

나오는 기능을 이용하여 다양한 방법으로 작곡할 수 있는 장점을 가지고 있다.

E. Nightingale

  피날레의 기능을 모두 가지고 있지는 않지만 사용하기 쉽고 속도도 빠르다. 가

장 큰 장점은 인쇄된 악보를 스캔해서 편집할 수 있는 기능이 있다.

F. Overture

  Encore 의 편리함과 연주용 소프트웨어인 Studio Vision Pro의 기능을 합쳐놓

은 것이다. 악보 제작용 프로그램으로는 이례적으로 피아노 음원을 윈도우 자체에

서 제공되며 실제로 연주될 음 하나하나에 대한 수정이 가능하다.  

4)컴퓨터 음악의 장점

(1)개별화 학습이 가능하다. 

학습자가 자신의 능력에 맞는 학습 속도로 진행할 수 있고, 개인의 필요성에 맞추

어 학습할 수 있어서 개인 지도에 유용하다.
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(2)반복 학습이 얼마든지 가능하다. 

반복적인 훈련을 요구하는 실기교육에 특히 유용하다.

(3)즉각적인 피드백을 제공해 준다. 

학생들이 직접 만든 작품을 바로 들어볼 수 있다.  

(4)청음 실력을 향상시키고 음악적 기술을 발달시킨다. 

실제악기 연주처럼 트레몰로, 글리산도, 강약 조절 등 모든 음악적인 표현을 하는 

기능이 있으므로 이를 활용한 음악적 능력을 발달시킬 수 있다.

(5)자신이 작업한 곡을 저장할 수 있다. 

만든 곡을 저장하여 언제든지 들어볼 수 있으며 입력된 곡의 중간에도 얼마든지 

삽입시킬 수 있다.

(6)부분 연주가 가능하다. 

테이프나 CD로는 부분 연주가 어려우나 컴퓨터 음악 프로그램에서는 도돌이표를 

클릭해 주는 것만으로 간단하게 조작할 수 있다.

(7)필요한 부분을 쉽게 찾을 수 있다. 

테이프나 CD에서는 특정 부분을 정확하게 찾기 어려우나 컴퓨터 음악에서는 마

디 번호나 페이지만 알아도 쉽게 찾을 수 있으며 악보를 보고 확인 할 수 있어 

정확하다.

(8)200여 가지의 다양한 음색을 사용할 수 있다. 

악기로 직접 연주하는 경우에는 그 악기 소리 한 가지 밖에 들을 수 없지만  컴

퓨터 음악에서는 얼마든지 여러 가지 악기소리로 들어볼 수 있다. 고등학교 음악 

수업에서 이를 활용하여 얻어지는 교육적 효과는 무한하며 연주되는 악기의 음색 

알아맞히기, 악기 음색의 어울림 등을 감지하는데 효과적이다.
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(9)악보를 인쇄할 수 있다. 

자기가 만든 곡을 인쇄하여 다른 사람에게 보여줄 수 있으며 연주할 수 있다. 여

러 곡을 모아서 개인이나 학급단위의 작곡집을 만들 수도 있다.

(10)템포 조절이 가능하다. 

음악의 분위기에 맞는 템포를 들어보면서 수정할 수 있고 곡의 일부분의 템포도 

변경할 수 있다.

(11)셈여림의 표현이 가능하다. 

채널별 셈여림은 물론 한 채널 안에서도 특정 음이나 마디의 셈여림을 표현할 수 

있다. 특히 셈여림의 강도는 숫자로 표시되기 때문에 비교되는 다른 부분과의 강

약을 세밀하게 표현할 수 있다.

(12)마디를 복사, 삭제, 붙이기 등을 손쉽게 할 수 있다. 

이러한 기능들은 곡을 수정하는데 편리하게 사용되며 같은 가락이 반복될 경우 

간단하게 복사하여 붙임으로써 작업의 효율성을 높일 수 있다.

(13)이조가 가능하다. 

가창 수업의 경우 반주 음악이 너무 높거나 낮아서 부르기 힘들면 조바꿈  메뉴

로 간단하게 해결할 수 있다. 관현악 편곡의 경우 조가 서로 다른 악기를 배열할 

때도 활용도가 높다.

(14)편곡하기가 쉽다. 

노트에 연필로 악보를 그리는 편곡은 누군가가 그 곡을 연주해 주어야만 음을 듣

고 수정하거나 보완할 수 있지만 컴퓨터 음악에서는 작업 도중에 일부분 또는 전

체를 들어 보며 어울림을 감지하여 수정할 수 있다.

(15)채널 별 연주가 가능하다. 
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전체 채널 연주, 멜로디 채널만 연주, 반주 채널만 연주, 특정 채널만 연주, 원하

는 몇 개의 채널만 연주가 가능하며 학습 목적에 맞게 이용할 수 있다. 예를 들면 

독창을 할 때 선율 반주로 익숙해지면 멜로디 채널을 제외한 나머지 채널만 선택

하여 무선율 반주로 노래할 수 있다. 이러한 기능은 테이프나 CD에서는 불가능하

다.

(16)박자가 정확하다. 

피아노로 직접 연주할 경우 정확한 박자로 연주한다는 것은 어려우나 컴퓨터 음

악 프로그램은 100%정확하게 연주된다. 특히 청음에 있어서 박자기 기능을 사용

하면 듣는 학생도 판단하기 쉽다.

(17)자동 반주를 사용할 수 있다. 

학생들은 한 도막이나 두 도막 형식의 가락을 짓지만 화음이나 타악기를 넣어 

편곡하기에는 무리가 있다. 이 때 컴퓨터 음악에서 제공되는 자동 반주를 이용하

면 20인조 이상의 훌륭한 편곡 효과를 얻을 수 있다. 기존의 프로그램은 50가지 

정도의 자동 반주를 제공하였지만 최근에 개발된 미디 프로그램은 400여 가지 

이상의 다양한 자동 반주를 제공할 뿐만 아니라 처음부터 끝까지 똑같은 음을 

내는 단조로움을 없앨 수 있는 intro, fill in, break, ending 등의 기능이 있어 

지금까지의 자동 반주 개념을 한 단계 높여 실제 편곡과 같은 효과를 낼 수 있

다.

(18)반주가 없어도 노래나 악기 연주를 할 수 있다. 

반주자가 없어도 반주 음악을 연주시키고 거기에 맞추어 노래나 악기 연주 연습

을 할 수 있다.

(19)창의력을 증진시키고 높은 단계의 사고력을 키울 수 있다. 

컴퓨터 음악은 소프트웨어의 기본 작동 방법 이외에 사용자의 음악적 아이디어와 

연구에 의하여 다양한 방법으로 사용되므로 창의력과 사고력을 키울 수 있다.
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(20)음악을 읽고 쓰는 능력을 증진시킬 수 있다. 

악보 작업을 하면서 끊임없이 입력하고, 보고, 듣고, 수정하는 과정을 통하여 독보

력과 청음감을 높일 수 있다.

(21)학생들의 음악수업에 흥미를 유발시킬 수 있다.

음악을 직접 듣고 악보를 볼 수 있으므로 기존의 전통적인 지필 사용의 음악 수

업에 비하여 학생들의 흥미를 유발시키는 효과가 크다. 또한 건반악기의 연주능력

이 부족한 학생들에게도 매우 효과적이다. 한 번에 한 음씩 입력이 이루어지므로 

누구나 음악을 만들 수 있으며 악기연주 능력과는 상관없이 자신의 음악적 능력

을 최대한 발휘할 수 있다.

(22)모든 학생들이 능동적으로 수업에 참여하게 할 수 있다.

학생들은 컴퓨터와 전자음악에 관심이 많으므로 기기를 소개함으로써 자발적인 

학습 의욕을 높이게 되어 학습의 효과와 능률을 높일 수 있다.

(23)그룹 간에 작업을 협력적으로 하여 학습효과를 높일 수 있다. 

그룹별 작업을 하면 그룹의 구성원 개개인의 장점과 단점을 보완한 활동을 할 수 

있으며 보다 나은 결과물을 얻을 수 있다.7)

(24)학생들 간에 우애를 증진시킬 수 있다. 

그룹을 편성할 때 학습자의 능력을 고려하여 잘하는 학생과 부족한 학생이 그룹

마다 골고루 섞이도록 하면 이러한 효과는 더욱 증대된다.

(25)서로를 칭찬하고 격려하여 음악에 대한 긍정적 태도를 가지게 할 수 있다. 

컴퓨터 음악을 활용한 경우 교사나 지도자의 일방적인 칭찬 이외에도 소프트웨어

를 이용하여 훌륭한 음악을 만든 데서 얻을 수 있는 성취감이나 보상 심리가 작

용하여 한층 높은 강화 작용을 할 수 있다.

7) 장창환∙조효임∙이동남, ⌜초등학교 음악과 지도법⌟, 서울:삼호출판사, p148.
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(26)교사의 음악적 기능을 보완해 주며, 다양한 음악적 정보를 빠르게 얻을 수 있

게 한다.8)

5)컴퓨터 음악의 단점

(1)악기 음질이 원음에 미치지 못한다. 

아무리 비싼 음원을 사용하더라도 악기 본래의 음질과 같을 수는 없다. 다만 원음

의 몇% 가깝게 재생되느냐 하는 것이다. 컴퓨터 음악에서 음질을 좌우하는 것은 

음원이다. 가능하면 저급 사양은 피하는 것이 좋다.

(2)개인주의에 물들기 쉽다. 

합창이나 합주를 통하여 음악을 완성하는 가운데 협동심과 인내심을 기를 수 있

지만 컴퓨터 음악에서 개인 학습만 강조할 경우 이런 문제점이 발생할 수 있다. 

그러므로 교사는 학습목표에 접근하기 위한 다양한 수업 방법을 구안 적용하여야 

하며 컴퓨터 음악의 활용에 있어서 개인 활동과 그룹 활동을 병행하는 수업을 전

개하여 이를 예방하여야 한다.

(3)교수 학습지도에 대한 배려가 부족하다. 

소프트웨어의 목적이 음악 제작, 악보 사보이기 때문에 음악 수업에 바로 적용하

기가 어려운 점이 있다. 따라서 교사는 지도 단원에 알맞게 컴퓨터 음악의 특성과 

장점을 살린 활동으로 재구성하여 활용해야 한다. 최근에는 교사 중심의 컴퓨터 

음악 동호회가 조성되어 활동하므로 학습 지도 사례가 개발되고 있고 인터넷 사

이트도 개설되어 있으므로 정보를 얻기 쉽다.

(4)모든 음악 표현 기교를 구사하기 위한 사용방법이 복잡하다. 

시퀀서 프로그램에서 지원하는 기능은 많이 있지만 모든 음악적 표현을 소화하여 

실제 연주처럼 효과를 내기 위해서는 프로그램의 복잡한 기능을 이해해야 한다. 

8) 석문주, 전게서, p248.
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학생들을 대상으로 한 음악 수업에서는 복잡한 기능을 잘 사용하지 않지만 전문

적인 음악 제작을 하기 위해서는 필요하다.9) 

2. 음악교육에서 컴퓨터의 활용

1) 음악교육에서 컴퓨터의 활용방법

교사들은 전통적 음악 수업의 문제점을 해결하기 위해 끊임없이 새로운 교수 방

법과 매체의 도입을 연구해 왔다. 1980년대 개인용 컴퓨터의 대중화와 함께 음악 

교육에서도 컴퓨터를 수업에 활용하고자 하는 노력이 시도되었다. 또한 

MIDI(Music Instrument Digital Interface)의 도입 이후 컴퓨터와 악기, 주변기기

간의 연결이 수월해져 컴퓨터는 음악 교육의 여러 분야에서 활용할 수 있게 되었

다.

컴퓨터를 음악 교육에 활용하는 방법에는 크게 두 가지가 있다.

(1) 멀티미디어 CAI (Computer Assisted Instruction)

많은 학자들이 컴퓨터를 수업에 활용하고자 하는 노력을 계속해 온 가운데 가장 

많은 성과를 거둔 부분이 CAI 개발 분야이다. 그러한 추세는 음악 교육에도 이어

졌다. 최근 개인용 컴퓨터가 고성능화, 고용량화 되고 여러 멀티미디어 부가 장비

의 도입으로 동영상 처리가 가능해지고 고속 CD-ROM의 개발은 음악 수업의 활

용도를 높여 주게 되었다. 예컨대 기존의 CAI가  텍스트와 그림 중심의 정보를 

제시한 반면 멀티미디어 컴퓨터에서는 음악과 동영상 제시까지 가능하므로 학습

자는 유명한 음악가의 작품이나 연주를 소리를 통하여 음악을 들을 수 있고 직접 

공연장에 가지 않더라도 동영상을 통해서 연주 실황을 눈으로 볼 수 있으며, 사진 

9) 최광석, “컴퓨터 음악을 활용한 음악 교수법에 관한 연구”, 춘천 교육대학교 교육대학원 석사학

위논문, 2000, pp23~24.
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자료를 통해서 음악가의 사진이나 악보를 볼 수도 있다.

또한 컴퓨터는 다양한 상호 작용을 가능하게 한다. 학습자는 단순히 컴퓨터 화면

에 제시된 정보를 보고만 있는 것이 아니라 컴퓨터가 요구하는 대로 학습자가 반

응을 하면 컴퓨터가 다시 반응에 대한 또 다른 반응이나 피드백(feed back)을 할 

수 있다. 예를 들면 어떤 곡의 악보를 보여주고 또 한쪽에서는 음악가의 사진을 

나열해 놓고 작곡가를 선택해서 클릭하게 할 수도 있고 어떤 한 음을 소리 내어 

주고 학습자에게 오선에서 어느 음에 해당하는 위치를 찾아 낼 수 있으며, 학습자

의 정답과 오답 반응에 따라 다양한 피디 백을 주기도 한다.

(2)교수 도구로서의 컴퓨터 음악 소프트웨어

MIDI(Music Instrument Digital Interface)의 출현 이후 음악 소프트웨어의 개발

이 가속화되었고 그것을 활용한 대중음악이나 영상 음악들이 속속 등장하게 되었

다. 이러한 컴퓨터 음악 프로그램을 활용하여 작곡, 편곡, 편집 등의 전문적인 작

업뿐만 아니라 화성, 리듬, 음정 교육, 악보 편집, 및 출력 등을 활용하면 교육 분

야에서도 그 활용 가능성이 높다고 할 수 있다. 

최근에는 일반인들이 사용하기 쉬운 프로그램들이 많이 나와 있으며, 이 프로그램

들의 특징은 악보 형태로 음악의 입력 및 출력이 가능하다는 것이다. 학생들은 마

우스 혹은 키보드와 아이콘을 이용하여 쉽게 악보를 입력할 수 있고 입력한 악보

를 컴퓨터가 연주해 준다. 또 전문가들이 만들어 놓은 기존의 MIDI 데이터들도 

악보형식으로 화면에 출력해 주기도 한다. 또한 다양한 악기의 음색을 제공하므로 

악기를 바꾸어가며 다양한 음색으로 음악을 들어 볼 수도 있다. 

이러한 컴퓨터 음악 프로그램의 특징을 활용하여 교수 도구 혹은 학습 도구로 활

용한다면 전통적인 음악 수업의 한계를 극복할 수 있을 것으로 기대된다. 우선 학

습자들은 직접 음표와 쉼표 등의 악보를 입력하고 지우고 편집하는 등 악보를 기

보한다. 또 악보를 기보할 뿐만 아니라 입력된 악보를 컴퓨터가 연주해주므로 자

신의 악보를 보면서 연주를 들을 수 있다. 그리하여 추상적인 기호 체계인 악보와 

구체적인 소리음악이 쉽게 연합할 수 있다. 또한 컴퓨터 음악을 활용한 수업에서 
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학습자는 단순히 교사를 따라 노래하거나 교사의 강의를 듣는데 그치는 것이 아

니라 직접 음악을 입력하고 또 연주해 보기도 하고 원하는 악기로 연주해 보면서 

악기의 음색을 들을 수도 있으므로 수업에 적극적으로 참여하게 된다. 이러한 과

정들을 통해 학습자는 음악의 단순한 소비자가 아니라 창조적 역할을 수행하게 

된다.10)

 

2) 음악교육에서의 CAI(Computer Assisted Instruction)의 적용

(1) CAI(Computer Assisted Instruction)의 개념 

우리말로는 ‘컴퓨터 보조 수업’ 이라고 말하며 학습 내용을 학생들에게 효율적으

로 학습시키기 위하여 학습 내용의 전달 매체로 컴퓨터를 사용하는 것을 말한다. 

다시 말하면 CAI란 컴퓨터를 이용하여 학습 목표에 따라 논리적이고 체계적으로 

구성된 학습 과정이 컴퓨터에 의해 제공되는 개별화된 교수 체제를 말하며, 이렇

게 수업 현장에서 쓰이는 교육용 소프트웨어를 통칭하여 코스웨어라 한다.

CAI와 유사한 용어로 CMI(Computer Managed Instruction)가 있는데 우리말로 

‘컴퓨터 경영 수업’이라 해석된다. 이것은 학생들의 성적 관리나 인적 사항에 관한 

정보를 관리하고 학생들의 학업 진전 상황을 분석하여 학습이나 수업의 개선에 

도움이 되는 정보를 제공한다.11) 이는 거시적 수준에서 교육에 관련된 행정 업무 

처리와 자료의 정리에 효율을 가져와 교사의 업무 경감으로 개별 상담과 적성 지

도에 더 많은 시간을 할애하는 효과를 가져 온다.

(2) CAI 프로그램 유형

가. 반복 학습형

선행 학습에 대한 반복 학습과 피드백(feed back)을 제공하며 문제에 대한 학생

의 반응을 바로 평가할 수 있기 때문에 정규 수업을 보완하는데 사용하게 되면, 

10) 최동근∙양용칠∙박인우, ⌜교육 방법의 공학적 접근⌟, 서울:교학사,1997, p67.

11) 김효정∙전게논문, p22.
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이미 습득한 개념을 강화하고 학습을 종합함으로써 학습능률을 높여 준다. 이는 

교사에 의해 이행되는 교수를 보조하는 형태이다.

나. 개인 교수형

컴퓨터의 자동적이고 자발적인 분지 능력에 의해 학습자에게 개별화된 반응을 해

주는 문답식 교수 방법 형태이다. 새로운 개념의 설명, 제시와 질문을 하여 피드

백을 제공하는 직선형과 직선형보다 더 많은 학습 내용을 첨가하여 학습을 더욱 

증진시키는 분지형이 있다. 학습자의 개별화는 학습자의 반응에 따라 다양한 내용

을 제시하여 주는 분지형이 바람직하다.

다. 교수 게임형 

컴퓨터의 수치 조작 및 그래픽, 애니메이션 제공 능력 등을 이용한 환상적이고 오

락적인 요소를 통하여 학습자의 흥미와 참여를 유도할 수 있으며 다양한 학습 방

법을 제공한다. 

이 형태는 선행학습의 강화 및 심화를 위해 활용하게 되며, 제한된 시간 내에 문

제를 해결하도록 하거나 어떤 기준의 설정에 의한 방법이다.

라. 모의 활동 학습형

실제의 현상을 최적으로 제시하거나 실험이 곤란한 것 또는 불가능한 것에 관하

여 컴퓨터 내에서 그것을 모의적 실현을 통해 그 결과를 화면에 표시하는 것이다. 

학습자가 통제하는 조건에 따라 실제 상황과 동일한 혹은 근접한 실험 결과를 제

공한다.

마. 문제 해결형

학습자가 컴퓨터의 정보 처리와 계산 능력을 이용하여 문제를 해결하는 형태이다. 

이 형태는 학습자가 문제를 해결할 때, 자주 틀리는 것에 대한 설명을 부가해서 

틀린 곳을 찾아 낼 수 있게 해야 한다. 만일 학습자가 틀린 곳을 찾지 못하면 단

계적으로 스스로 해결하는 방법을 찾아낼 수 있게 유도해야 한다.
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교수자는 어느 코스웨어가 교수 내용과 학습자의 특성에 보다 적절한지, 또한  교

수 목표 달성에 효율적인지에 대한 판단이 매우 중요하다.

(3)CAI 교육의 해결해야 할 문제

CAI의 교육은 전통적인 교육방법 보다는 학습 능률을 보다 높을 수 있으나 현장

에서 실시할 때 몇 가지 제한점을 가지고 있다.

첫째. 학습에 필수적인 코스웨어가 빈약하다. 

아직은 보편화가 이루어지지 않았고 일부 과목에 치중되어 있다.

둘째. 교사가 직접 코스웨어를 제작하려면 많은 지식을 습득해야 하고 시간이 필

요하다. 

유용하고 효율적인 교수 프로그램을 위해서는 프로그래밍, 시청각 자료, 교육 과

정 등 모든 면에서 다각적이고 깊이 있는 지식을 필요로 하기 때문이다.

셋째. 시판되는 CAI 프로그램들 중 일부는 단편적이고 일률적이어서 독창적이고 

창의적인 학습을 이끌지 못하기도 한다.

넷째. 학습 과정이 기계적으로 통제되기 때문에 심리적 저항감을 유발할 수 있고, 

교수∙학습 상황에서 사전에 계획되지 않았던 학습은 배제될 우려가 있다.12)

    

3. 컴퓨터 음악을 활용한 구체적 수업방안

1) 가창 수업

가창 수업은 중요한 수업 활동이다. 

12) 이미애, “멀티미디어 제작도구를 이용한 개별학습 코스웨어 설계 및 구현”, 이화여자대학교 교

육대학원 석사학위논문,1994, p14.
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단    원        1. 애니로리
차    

시
   3/3    교 과 서    24쪽

일    시     .    .    .(   )교시
장    

소
           멀티미디어실

수업모형  컴퓨터 음악 가창수업 모형 학 습 자 (교사) 컴퓨터, 제재곡 미디파일

그 이유는 첫째, 대부분의 음악적 경험은 노래를 부르고 배우는 것에서 시작하여 

점점 음악적 능력이 향상되고, 둘째, 학생들이 자신의 목소리를 악기로 사용하여 

처음으로 음악을 창의적으로 표현하는 활동이기 때문이다. 

가장 수월하고 직접적인 방법으로 자신의 느낌과 생각을 노래로 표현하며 미적 

체험을 하고, 음악 개념을 형성하여 자신의 감정을 창의적으로 표현하는 기회를 

가질 수 있다는 점에서 매우 중요한 음악 활동인 것이다.

따라서 학생들의 가창능력을 향상시키는 것은 음악 교사의 중요한 역할인데, 여러 

단계의 과정을 거쳐야 한다. 즉 자세, 발성, 듣고 따라 부르기, 악곡의 특성을 살

려 부르기, 외어 부르기, 합창으로 부르기, 노래를 듣고 평가하기 등의 과정이 필

요하다. 그 중 화음으로 노래하는 합창으로 부르기는 가창학습에서 가장 즐거운 

경험인데,13) 교실에서 화음을 경험하기 위한 방법은 여러 가지가 있는데, 돌림 노

래, 악기로 코드 연주하기, 코드를 노래하기, 2부 합창 등이 그것이다. 이런 활동

에 컴퓨터 음악을 활용하면 흥미 있는 가운데 수업 목표에 도달할 수 있다. 

1) 단원명 : 애니로리

2) 학  년 : 고등학교 2학년

3) 시스템 요구 : 3채널. 음색 변환, 채널별 연주

4) 컴퓨터 사용 : 교사, 학생

5) 본시 교수 ･ 학습 지도안

6) 교과서 : 박영사

<표 1> 애니로리

13) 길애경∙임미경, ⌜초등 음악지도법, 서울:도서출판 수문당⌟, 1997, p76.
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료 (학생) 컴퓨터

수업목표  악곡을 다양한 방법으로 화음을 구성하여 부를 수 있다.

단계 지도요소               교수･학습활동 시간 지도상의 유의점

감각적 감 

  지

동기유발

화음도입

∎노래 부르기 위한 분위기를 조성한다.

∎화음 노래한 경험을 이야기해 보자.

∙학교에서, 교회에서, 합창대회 참가

∎화음과 노래의 중요성에 대해서 설명

∎제재 곡을 소프라노 가락으로 불러 보

자.

10분

화음으로 노래 불

러서 느낀 좋은 감

정을 발표하게 한

다.

표 현 방 법 

다 양 화

2 부 합 창 

하    기

합창완성

 

∎미디 파일로 부분 2부 합창을 들어보

자.

∙화음을 생각하며 듣는다.

∎미디파일의 알토 채널 연주를 들으며 

노래 부르자.

∎익숙해질 때까지 불러 보자.

∙개임별, 그룹별, 전체 단위로 부른다.

∎미디 파일의 소프라노 가락에 맞추어 

알토 가락을 부르자.

∙알토 가락을 느끼며 노래 부른다.

∎두 파트로 나누어 미디의 무선율 반주

에 맞추어 2부 합창하여 보자.

∙다른 파트와 어울리게 부른다.

15분

1,2 차시에 소프라

노 가락을 충분히 

익힌 후 알토를 부

른다.

창조적 표 

  현

오 스 티

나 토 

만 들 기

작품평가

∎미디 파일로 제시한 이 곡을 한 채널 

추가하여 오스티나토를 완성해 보자.

∙그룹별로 의논하여 한 마디의 오스티나

토를 만들어 나머지 마디에도 복사한다.

∎어울리는 가락과 함께 연주하여 보자.

∙들어보며 수정한다.

∎채널그룹의 오스티나토를 동시에 들어

보자.

∎미디 가락에 맞추어 그룹의 오스티나

토를 동시에 노래하자.

15분

멜로디와 오스티나

토의 악기를 다르

게 하여 듣는다.
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단    원       3. 우울한 왈츠
차    

시
   3/3    교 과 서    58쪽

일    시     .    .    .(   )교시
장    

소
           멀티미디어실

수업모형  컴퓨터 음악 기악수업 모형
학 습 자

료

(교사) 컴퓨터, 제재곡 미디파일

(학생) 컴퓨터

수업목표  제재곡을 연주하고 가락에 어울리는 음색과 자동 반주를 고를 수 있다

2) 기악 수업

기악 활동은 악기를 연주해야 한다는 어려움 때문에 가창과 비교하여 음악수업에

서 제한적으로 활용된다. 그러나 악기연주는 풍부한 음악적 표현력에 대한 학생들

의 감수성을 증진시키는 효과적인 활동이다. 자신의 느낌과 생각을 악기로 표현하

며 미적 체험을 하고, 음악 개념을 형성하고, 자신의 감정을 창의적으로 표현하는 

기회를 가질 수 있다는 점에서 매우 중요한 음악 활동인 것이다. 그래서 교사는 

음악적 개념 발달을 위해서 학습 목표에 부합하는 의미 있는 음악 활동을 이끌어 

가야하며, 수업에서 전개되는 음악활동이 학생의 수준에 적합하여 개개 학생들에

게 매우 의미 있고 가치 있는 경험이 되도록 충분히 도와주어야 한다.14)

기악 중심 수업에서도 컴퓨터 음악의 활용도와 이용가치는 매우 높다. 그러므로 

지도 단원에 맞게 활용하면 교육적 효과를 충분히 얻을 수 있다.

1) 단원명 : 3. 우울한 왈츠

2) 학 년 : 고등학교 2학년

3) 시스템 요구 : 음색 변환, 채널별 연주, 이조

4) 컴퓨터 사용 : 교사, 학생

5) 본시 교수 ･ 학습 지도안

6) 교과서 : 대한교과서

<표 2> 우울한 왈츠

14) 장창환∙조효임∙이동남,전게서, p73.
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단계 지도요소               교수･학습활동 시간 지도상의 유의점

감각적 감 

  지

동기유발

수 업 목 표

근    접

∎기악합주에 대한 경험을 이야기 해보

자

∎그 때 연주했었던 악기들은 무엇인가?

∎연주해 보고 싶은 악기의 이름과 음색

의 특징을 말해 보자

∎제재곡을 노래로 불러보자

10분

악기의 음색과 관

련된 경험을 유도

한다.

표 현 방 법 

다 양 화

 

가락연주

2 중 주

듣   기

미 디 와

2  중 주

음    색 

고 르 기

∎가락을 멜로디언으로 연주해 보자.

∎셈여림을 살려 연주해 보자.

∙모니터에 제시된 악보를 보면서 연주한

다.

∎미디 파일로 2중주를 들어보자.

∙주선율과 부선율의 어울림을 느끼며 듣

는다.

∎미디파일 부선율의 연주에 맞추어 가

락을 연주해 보자.

∙셈여림 음량을 조절하며 연주한다.

∎부선율의 음색을 바꾸어 연주해 보자.

∙컴퓨터 음악 프로그램에서 음색을 들어

보며 고른다.

∎두 파트로 나누어 주선율과 부선율을 

같이 연주해 보자.

∎파트를 바꾸어 연주하자.  

15분

부선율의 음색은 

주선율과 구별되는 

것을 고른다.

창조적 표 

  현

피아노 반 

  주

자 동 반 주

고 르 기

반 주 맞 춰

연    주 

∎피아노 반주 부분을 입력하여 보자.

∙교과서를 보고 미디 파일에 파아노 반

주를 추가 입력한다.

∎가락에 어울리는 자동 반주를 골라 보

자.

∙개인별로 자동 반주를 골라 입력한다.

∎부선율 가락의 채널을 mute 시키고 

play 하면서 멜로디언으로 부선율 가락

을 연주하여 보자.

∎부선율 가락을 좋아하는 음색으로 지

정하자.

∎주선율의 가락을 mute 시키고 부선율, 

파아노, 자동 반주를 play 시키면서 주

선율을 멜로디언으로 연주해 보자.

15분

주선율이나 부선율

의 음색은 학생이 

배우지 않은 악기

로 연주시키는 것

이 효과적이다
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단    원        6. 스와니 강
차    

시
   3/3    교 과 서    103쪽

일    시     .    .    .(   )교시
장    

소
           멀티미디어실

수업모형  컴퓨터 음악 창작수업 모형
학 습 자

료

(교사) 컴퓨터, 제재곡 미디파일

(학생) 컴퓨터

수업목표 악곡의 짜임과 구성 요소를 알고 내림 나장조 한 도막 형식의 곡을 작곡할 

3) 창작 수업

음악 교육에서 말하는 창작이란 표현학습 활동 속에서 개성에 따라 창조적으로 자

기를 표현하는 기회를 충분히 마련함으로써 음악을 만들어 나가는 즐거움을 맛보

게 하고 자신의 음악적 세계를 상상, 창조하는 등의 경험을 쌓게 함으로써 창조하

는 마음과 태도 및 능력을 기르고자 하는데 있다.

그러나 현장 음악 학습에서의 창작 학습은 실음 중심이기 보다 학생들이 떠오르는 

악상을 오선지에 그려서 악기 연주로 표현하는 형태로 진행되기 때문에 학생들의 

창작에 대한 흥미도가 낮다. 이를 극복하기 위해서는 실음 중심의 창작 수업이 이

루어져야 한다.

그 방안은 컴퓨터로 음악을 활용한 실음 중심의 다양한 학습 활동을 함으로써 학

생들은 음악적 개념을 습득하게 되고 교사는 학생들이 수업에서 보여주는 음악 행

위를 통하여 개념의 이해 정도를 관찰하여 파악할 수 있다.

1) 단원명 : 스와니 강

2) 학  년 : 고등학교 2학년

3) 시스템 요구 : 음색 변환, 채널별 연주

4) 컴퓨터 사용 : 교사, 학생

5) 본시교수 ･ 학습 지도안

6) 교과서 : 교학사

<표 3> 스와니 강
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수 있다.

단계 지도요소               교수･학습활동 시간 지도상의 유의점

감각적 감 

  지

동기유발
∎제재곡을 불러 보자.

∎주요 리듬을 익히고 계이름으로 불러

보자.

 5분

기 초 기 능 

파    악 

 기본화음

이    해

∎노래의 첫 음과 마지막 음의 화음은?

∙I도를 사용한다.

∎첫 줄 마지막 음과 둘째 줄 첫 음의 

시작은 어떤 화음인가?

 5분
주어진 곡에서 확

인 한다.

방법의 탐 

  색

가 락 듣 고 

구별하기

제재곡 연 

  주

∎가락을 듣고 끝나는 느낌과 계속되는 

느낌을 구별하여 보자.

∙컴퓨터의 스피커를 통하여 나오는 멜로

디를 듣고 구별한다.

∎컴퓨터로 ‘스와니 강’을 연주해 보자.

∙화음을 생각하며 연주한다.

 5분

전체적인 악곡의 

흐름 속에서 갑지

한다.

창조적 표 

  현

주 제 동 기 

이어서 가

락짓기

음색변환

자 동 리 듬 

고 르 기

∎제시한 주제 동기에 이어 나머지 부분

을 완성해 보자.

∙파일을 열어 나머지 부분을 완성한다. 

∎연주하여 보자.

∙완성된 곡을 악기를 지정하여 연주한다.

∎악기를 바꾸어 연주하여 보자.

∙가락에 어울리는 음색을 고른다.

∎자동 리듬을 골라 보자.

∙곡의 분위기에 맞는 리듬과 간주음, 끝

내기 효과를 지정하면서 들어본다.

20분
주제, 동기는 미리 

준비한다.

내 면 화

음악완성 ∎완성된 가락에 악상기호를 붙여 보자.

∙어울리는 음색과 자동 반주를 확인하고 

셈여림, 강약, 템포 등의 악상 표현을 하

5분

창작된 곡은 프린

트하여 게시하고 

불러본다.
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화음에 어

울리는

가락짓기

여 연주한다.

∎제시된 곡을 연주해 보고 비어 있는 

한 마디의 가락을 완성해 보자.

∎들어 보면서 빈 마디의 화음을 알아낸 

후 앞뒤의 마디와 어울리는 가락을 채운

다.  

4) 감상 수업

감상이란 음악을 마음으로부터 느껴 아름다움을 맛보는 일이다. 또는 미묘한 지각

대상 특히 심미적 특성이나 가치를 음미하고 이해하는 것이라고 정의한다. 다시 말

하면 감상은 음악을 미적 대상으로 받아들이는 것이며, 이것은 청각을 통해서만 이

루어 질 수 있다. 또한 이것을 형성하고 인식하는 근본적 활동이 되는 것이다. 

감상교육은 그 본질적인 목표를 달성하기 위해 재생 음악만을 감상하는 학습이 되

어서는 안되는 것이며, 음악미에 대한 학생들의 자연 본능적인 욕구를 자극함으로

써 능동적이고 적극적으로 ‘음’의 아름다움을 추구하려는 마음자세를 길러주어야 

한다. 동시에 음악미를 정확하게 받아들일 수 있는 능력인 음악성 및 음악적인 여

러 기능 등이 갖추어 질 수 있도록 해야 한다. 그러므로 완전한 감상은 또한 창조

적인 행위로 볼 수 있으며 진, 선, 미를 추구하는 높은 차원의 음악예술이므로 생

각과 감정이 ‘음’이란 매체를 통하여 숭고한 예술로 승화되어 정서의 안정에 도움

이 되며, 사회성 발달에도 많은 도움을 줄 수 있다.

종합적으로 감상을 위해선 분석적인 감상 즉 주된 가락 파악, 곡의 특징(박자, 리

듬, 조성, 셈여림) 음색, 악곡의 표현 내용 등을 분석하면서 악곡의 분위기를 느낄 

수 있도록 감상하는 것이다. 우리는 이런 감상이 되도록  교육하기 위해서 컴퓨터 

음악으로 들려줄 음악을 만들어 감상하는 것이다.

컴퓨터 음악을 활용한 감상 수업은 지금까지 사용해 왔던 테이프나 CD 자료에서 

벗어나 새로운 매체로 관심을 유발할 수 있을 뿐만 아니라 다음과 같은 기능을 활

용할 수 있는 장점을 지니고 있다.
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첫째, 연주 형태의 선택이 편리하다. 

녹음기나 라디오로 감상하면 관현악곡의 총보를 그대로 들어야 하지만 컴퓨터 음

악을 이용하면 파트별 연주, 그룹별 연주, 전체 합주 등 자유롭게 선택하여 감상할 

수 있다.

둘째, 음색 변경이 자유롭다. 

기존 매체에서는 연주된 악기의 음색을 바꿀 수 없지만 컴퓨터 음악을 활용하면 

자유롭게 음색을 변경할 수 있다.

셋째, 감상할 위치를 찾기가 편리하다. 

기존 감상 매체에서는 곡의 중간 부분을 찾아 들으려 할 때 정확한 위치를 바로 

찾기가 어렵지만 컴퓨터 음악 안에서는 곡의 중간 어느 부분이든지 바로 찾아서 

연주할 수 있다.

넷째, 빠르기 변화가 가능하다. 

기존 매체에서는 빠르기를 변화하기 어려울 뿐 아니라 변화시켜도 소리가 이상하

게 변하지만 컴퓨터 음악은 얼마든지 빠르기 조절이 가능하며 음색에 변화를 주지 

않는다.

다섯째, 셈여림의 조정이 가능하다. 

기존 매체에서는 전체적인 볼륨을 크거나 작게 하는 것이 고작이지만 컴퓨터 음악

에서는 전체적인 볼륨 조정은 물론이고 특정 부분의 셈여림도 변화시킬 수 있어 

감상자가 곡을 재해석하여 음악을 재구성할 수 있다.

1) 단원명 : 미뉴에트

2) 학  년 : 고등학교 2학년

3) 시스템 요구 : 음색 변환, 채널별 연주, 셈여림 변화, 빠르기 변화, 이조 

4) 컴퓨터 사용 : 교사 학생
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단    원        13 미뉴에트
차    

시
   3/3    교 과 서    140쪽

일    시     .    .    .(   )교시
장    

소
멀티미디어실

수업모형  컴퓨터 음악 감상수업 모형
학 습 자

료

(교사) 컴퓨터, 제재곡 미디파일

(학생) 컴퓨터

수업목표  악기의 음색을 듣고 맞추며 창의적인 표현을 할 수 있다.

단계 지도요소               교수･학습활동 시간 지도상의 유의점

감각적 감 

  지

동기유발

악곡감상

∎음악 감상을 위한 분위기를 조성한다.

∎악기의 종류를 말해보자

∙현악기, 관악기, 타악기를 구별한다.

∎‘미뉴에트’의 작곡배경을 설명한다.

∎곡을 감상해 보자.

10분

다양한 방법으로 

악기에 대한 호기

심을 유발한다.

표 현 방 법 

다 양 화

 

음색파악

채널별 연 

  주

음색변환

∎한 번 더 들으면서 주된 가락의 악기 

음색을 알아보자.

∙들은 후 몇 명이 대답한다.

∎미디 파일로 한 채널만 연주하면서 음

색을 알아보자.

∙연주를 듣는다.

∎미디 파일로 두, 세 채널을 연주하면

서 그 속에서 주된 악기의 음색을 가려

듣자.

∙여러 음색 중에서 주된 가락의 음색을 

구별하여 듣는다.

∎악기의 음색을 바꾸어 들어보자.

∙미디 파일을 받아 악기를 바꿔가며 다

15분

개인별 또는 그룹

별 활동을 할 때는 

다른 사람에게 방

해가 되지 않도록 

볼륨을 조절한다.

5) 본시 교수 ･ 학습 지도안

6) 교과서 : 세광음악 출판사

<표 4> 미뉴에트
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양한 음색을 듣는다.

∙몇 사람의 변환된 곡을 듣는다.

∙원 곡의 악기와 비교하면서 듣는다.

창조적 표 

  현

이조하기

연주하기

악곡해석

비교평가

∎악보를 다장조로 바꾸어 보자.

∙조옮김 메뉴에서 다장조를 선택하고 확

인을 누른다.

∎주된 가락을 멜로디언으로 연주해 보

자.

∙변환된 가락을 인쇄하여 보면서 연주한

다.

∎감상을 한 번 더 들으면서 자신이 표

현하고 싶은 셈여림, 빠르기를 구상해 

보자.

∙미디 파일을 전체 또는 일부분 들으면

서 자기의 악상을 표현한다.

∙음색, 빠르기, 셈여림 등을 새로 지정하

면서 수정한다.

∎몇 사람의 곡의 들으며 느낌을 말하

자.

∙자기의 곡과 친구의 곡을 비교하며 말

한다.

15분

악기의 음색과 악

곡의 특징을 살려 

표현하도록 한다.
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Ⅲ. 결론 및 제언

1. 결론

본 연구는 21C 정보화 사회에서 학생들이 보다 나은 양질의 음악을 컴퓨터음악을 

통해서 음악적 잠재 능력과 풍부한 음악적 감수성과 바람직한 가치관을 길러 음악

을 생활화하는 것에 중점을 두고자 한다. 기존의 음악 수업에서는 CD플레이어, 피

아노, DVD 등의 교수 매체들을 사용하였지만 또 하나의 새로운 도구로서 컴퓨터

가 등장하고, 컴퓨터의 교육적 활용을 위한 각종 소프트웨어의 개발 또한 활발해지

고 있다. 

정보화 시대에서 피아노 반주만으로는 학생들의 다양한 음악적 취향을 충족시키기

에는 역부족으로 이것은 학생들이 음악에 대한 흥미를 잃어버리는 요인으로 지적

되어, 일선 학교들이 다양하게 새로운 시도를 했지만 많은 악기와 연주의 문제점으

로 고민해 왔었다.

하지만 컴퓨터와 미디 프로그램을 활용한다면 다음과 같은 음악적 효과를 얻을 수 

있다고 본다.

첫째, 컴퓨터 음악은 학생들이 흥미롭게 관심을 가지고 접근할 수 있는 학습 도구

로서 학습 의욕을 증진시킬 수 있다.

둘째, 오케스트라 편곡과 악기의 음역에 알맞은 반주곡으로 이조할 수가 있어 학생

들에게 연주 능력을 길러 준다.

셋째, 정확한 템포의 메트로놈 기능이 있으므로 청음 지도에 아주 효과적이다. 

넷째, 기존의 모든 악기 음색을 가지고 있어서 다양한 학습에 활용할 수 있다.
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예를 들어 가창수업에서 채널을 파트별로 지정해서 각 파트의 노래를 들을 수 있

고 감상수업에서는 멜로디 부분이과 반주 부분의 악기 음색을 듣고 어울리는 악기

를 배치해서 감상하는데 효과적으로 사용할 수 있다.

다섯째, 부분 연주 반복 연주 기능을 활용하여 반복학습, 보충학습을 할 수 있다.

여섯째, 마디의 복사, 삭제, 붙이기 기능을 활용하여 음악 작업을 간편하게 할 수 

있다.

이러한 장점을 가지고 있는 컴퓨터 음악을 적극적으로 활용한다면 음악 수업을 흥

미 있고 창의적인 수업방식으로 이끌 수 있으며, 학습에 대한 자기 주도적인 학습 

능력이 향상되어 학업 성취도가 향상되고 학습효과를 극대화 할 수 있을 것이다.

2. 제언

본 연구자가 연구하면서 제언하고 싶은 내용은 다음과 같다.

첫째, 컴퓨터 음악을 활용한 수업은 학습자의 악보읽기 능력을 향상시켜 주며 특

히, 악보와 소리를 같이 들을 수 있어 학습에 효과적이다. 

둘째, 컴퓨터 음악에서 간과해서는 안 될 것은 학생들의 관심과 실제적인 내용이

다.

클래식 음악에 관심이 없는 학생들에게 대중음악을 수업내용에 다루어서 학생들

이 흥미를 가진다면  효과적인 수업이 이루어진다.

셋째, 본 연구에서 제시된 여러 가지 교수법과 같은 수업을 전개하기 위해서는 하

드웨어와 소프트웨어가 학교마다 교육 기자재로 선정, 구비됨이 타당하다고 생각
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한다. 

마지막으로, 컴퓨터 음악을 학교 현장에서 수업하며 심사숙고해야 할 것은 컴퓨터 

음악 자체는 교육의 목표가 될 수 없으며 가장 아름다운 소리는 자연의 소리임을 

인식해야 한다.
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부  록

� Cubase 사용법

1.바탕화면에 있는 Cubase 바로가기를 더블클릭한다.

2.프로젝트 오픈

Cubase 바로가기를 더블클릭하면 위와 같은 Cubase창이 열린다.

아래에 있는 조그만 창은 "Transport Panel"이라고 하고 모든작업의 기본적인 컨

트롤창이라 보면 된다.

이 창에서 할수 있는 작업은 현재 녹음설정 상태, 녹음 신호가 들어오는지의 여

부, 녹음방법 설정등의 여러 정보와 재생, 되감기, 빨리감기, 녹음 등 기본적인 

기능이 있다.
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3.File -> New Project를 선택하여 새로운 프로젝트를 만든다.

프로젝트라는 것은 작업하는 작업의 단위라고 생각하면 된다.

곡을 만들 때 미디 데이타와 오디오 데이타 그 밖에 각 부분에 걸친 설정값이 

있어야 한다. 이것을 모두 프로젝트라 합니다. 즉 한 곡당 한 프로잭트에서 모든 

작업을 하는 것이다.

4. Empty -> OK를 클릭한다.

프로젝트의 프리셋이라고 보면 된다. 

악기마다 미리 정해놓은 설정 값만을 가지고 사용한다는 것이다.
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5. 디렉토리를 선택한다.

이 디렉토리는 프로젝트가 저장될 폴더를 나타낸다.

6.Project Windows(프로젝트 윈도우)

이창이 모든 작업의 기본이 되는 Project Windows(프로젝트 윈도우)다.
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7.Devices -> VST Instruments를 눌러서 VST Instrument Window를 열어

준다.

모든 단축키는 각각의 이름 오른쪽에 나타나며 외우면 작업에 많은 효율성을 가

져온다.

8.VST Instrument Window가 열린다.

VST Instrument Window를 대개 VSTi-Rack (브이에스티아이-랙)이라고 한다.
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9." No VST Instrument "부분을 클릭하면 아래로 자신이 설치한 VSTi들의 

목록이 나타난다.

" No VST Instrument "부분을 클릭하고 Cubase에 기본적으로 들어있는 ‘a1’을 

선택한다.

10. 설정이 되면 작은 창이 나타난다.

위와 같은 작은 창이 나타난 것을 확안하고 ‘e’ 버튼을 클릭한다
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11. ‘a1’의 악기가 창에 뜬다.

‘a1’의 악기의 음향효과를 이 창에서 모두 작업할 수 있다.

12. 트랙리스트에서 오른쪽버튼을 눌러주고 "Add MIDI Track"을 클릭한다.

프로제트 윈도우 왼쪽에 세로로 2칸의 빈 공간이 있다.

맨 왼쪽을 Inspector라고 하며 선택된 각종 정보를 보여주며 설정할 수 있는 곳

이다.

옆에 있는 공간은 Track list라고 한다. 여러 가지 트랙 부분이 한꺼번에 보이고 

간단한 설정도 가능하다.
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13. 미디트랙을 추가한후에 out을 클릭한다.

out을 클릭하면 여러 가지 미디아웃이 나타나고 ‘a1’을 선택해주면 된다.

14. a1에 있는 악기의 음색을 선택한다.

마스터 건반이 연결되어 있다면, 건반에서 a1의 소리가 바로 들릴 것이다. 

소리를 들어보면서 자신이 원하는 음색을 선택한다.
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15.작업범위를 설정해 준다.

트랙 리스트 오른쪽에 나오는 트랙 윈도우를 보면 1, 9, 17……. 숫자가 보이는

데 이곳을 Ruler라고 하는 곳으로 트랙의 위치를 지정해주는 곳이다.

룰러에서 Alt키와 함RP 마우스 왼쪽 버튼을 누르면 누른 부분까지 위와 같은 파

란색 막대기가 생긴다. 

양쪽 끝부분을 보면 삼각형 모양이 서로 안쪽을 향하고 있으며, 이것이 녹음의 

사작과 끝을 나타내주는 부호이다.

그 다음 트랙리스트를 보면 4개의 버튼이 보일 것이다. 동그라미가 그려진 빨간

색 버튼은 Record설정버튼이고 이 버튼이 눌려져 있는 트랙이 바로 지금부터 녹

음이 될 트랙이라는 뜻이다.  

트랜스포트패널에서 Click이라 쓰여 있는 이 부분이 메트로놈입니다. 학생들이 

메트로놈을 들으면서 녹음할 수 있도록 이 버튼을 클릭한다.

동그라미가 그려진 부분은 "Recoding"버튼이다. 이 버튼을 클릭하면 녹음이 시

작된다.
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16.녹음을 시작한다.

새로운 미디클립이 생기는 것을 볼 수 있을 것이다. 연주되는 미디데이타가 실시

간으로 보며 녹음한다.

17.녹음한 곡을 정지한다.

멈추려면 키보드에서 숫자 ‘0’을 눌러주면 된다.

녹음된 미디클립을 더블클릭한다.
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18. Key Editor(키 에디터)창이 나타난다.

녹음한 부분의 멜로디 라인을 한 눈에 볼 수 있고 미디노트의 값을 바꿀 수도 

있다.

Key Editor(키 에디터)창을 잠시 닫는다.

19. 트랙윈도우를  확대한다.
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화살표가 있는 부분에서 가로, 세로의 크기를 조절할 수 있다. 초록색 동그라미

가 그려져 있는 부분을 누르면 화면이 작아지고 빨간색 동그라미가 그려진 부분

을 누르면 화면이 커진다. 화살표가 가리키는 슬라이드 바도 똑같은 일을 한다.

20. R로케이터값을 설정한다.

  

Alt+마우스왼쪽버튼을 이용해서 우리가 녹음한 미디클립의 뒤쪽에 R로케이터가 

오도록 맞춰

준다.

녹음한 부분만 데이터로 만들기 위해서다.
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21. File -> Export -> Audio Mixdown......

 File -> Export -> Audio Mixdown...을 선택하면 현재 지정된 부분이 모두 

Export된다.

이때 Export되는 트랙은 Vsti로 설정한 미디트랙이다.

외장형 악기는  Export되지 않으니 주의해야 한다.

22. Mixdown을 눌러 준다.
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Mixdown된 파일을 어디에 둘 것인가 정하는 곳이다.

File name: 이라 곳에 제목을 적는다.

23. OK을 누르면 다음과 같은 창이 뜨면서 Export를 시작한다.

파란 그래프가 올라가면서 처리된 정도를 Export한다.

24.프로젝트를 닫기 위해선 Window -> Close All을 눌러 준다.
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마무리 하기 위해서 프로젝트를 닫아야 한다.

위와같이 Window -> Close All을 눌러주거나 오른쪽 위에 있는 X버튼을 클릭한

다.

25. 저장하기

 

프로젝트를 저장하고 작업을 끝낸다.
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Teachers have continuously studied on development of new teaching methods and 

new media to solve the problems that traditional music classes created. As 

personal computers became common in 1980s, attempts to use computers in 

music education had been made. Moreover, the introduction of MIDI(Music 

Instrument Digital Interface) made easier connections among computers, musical 

instruments, and other peripheral devices. This led more usage of computers in 

various areas of music education. Particularly, computer music softwares are now 

used not only for professional purpose of composing, arranging, and editing but 

also for educational purpose of teaching harmony, rhythm, tune, and score 

arranging and printing. 

The conclusion of this paper is summarized as following.

First, to use computers in music education can make students pay more attention 

to the class. It is very effective since students can vividly listen to music and 

see the scores in this case contrast to previous traditional music class where 

paper-and-pens are only used. Further, it can also work well for students with 

little skills in playing the keyboard instruments. For notes are input one at a time, 

anyone can compose and display musical ability regardless one's capability of 

playing musical instruments. 
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Second, every student can actively participate in class. Since students are very 

interested in a computer and electronic music, introducing instruments to them 

can raise their voluntary learning will as well as effectiveness and efficiency of 

the learning.

Third, students can print out scores. They can print out their own music, share 

the scores with other people, and play the music. They can also make a 

collection out of music from one person or from several people.

Fourth, tempos can be controlled. Students can adjust the whole tempo of music 

or partial tempos as well.

Fifth, dynamics can be expressed. Not only dynamics within a channel but also 

dynamics of a certain tone or of a measure are displayed. Especially, as they are 

described in numbers, a detailed comparison of them is possible.

Sixth, it is easy to copy, cut, and paste MIDI. These functions are convenient in 

editing; simply cutting and pasting repeated same keys would make work more 

efficient.

Seventh, transposition is possible. A transposition menu easily solves the problem 

of singing class where students may have difficulty singing to the accompaniment. 

It is also useful in arranging musical instruments with different keys in orchestras.

Eighth, it is easy to arrange. In computer music, one can edit music, listening to 

a part of or the whole music in the middle of arranging work. Someone else to 

play the music is no more necessary. 

Ninth, students can play each channel separately. They can play the whole 

channel, melody channel only, accompaniment channel only, a particular channel, 

or some channels, and utilize this function for learning purpose. For instance, 

when singing a solo, one can sing to all channels but a melody channel after 

being used to the melody accompaniment. This is impossible when using tapes or 

CDs.

Last, students can praise and encourage each other, so obtain a positive attitude 

on music. The use of computer music provides students with a sense of 

achievement or compensation as well as teachers' praises.
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